§ software

webMethods EntireX

EntireX .NET Wrapper

Version 10.7

October 2020

WEBMETHODS



This document applies to webMethods EntireX Version 10.7 and all subsequent releases.
Specifications contained herein are subject to change and these changes will be reported in subsequent release notes or new editions.

Copyright © 1997-2020 Software AG, Darmstadt, Germany and/or Software AG USA, Inc., Reston, VA, USA, and/or its subsidiaries
and/or its affiliates and/or their licensors.

The name Software AG and all Software AG product names are either trademarks or registered trademarks of Software AG and/or
Software AG USA, Inc. and/or its subsidiaries and/or its affiliates and/or their licensors. Other company and product names mentioned
herein may be trademarks of their respective owners.

Detailed information on trademarks and patents owned by Software AG and/or its subsidiaries is located at
http://softwareag.com/licenses.

Use of this software is subject to adherence to Software AG's licensing conditions and terms. These terms are part of the product
documentation, located at http://softwareag.com/licenses/ and/or in the root installation directory of the licensed product(s).

This software may include portions of third-party products. For third-party copyright notices, license terms, additional rights or re-
strictions, please refer to "License Texts, Copyright Notices and Disclaimers of Third-Party Products". For certain specific third-party
license restrictions, please refer to section E of the Legal Notices available under "License Terms and Conditions for Use of Software AG
Products / Copyright and Trademark Notices of Software AG Products". These documents are part of the product documentation,
located at http://softwareag.com/licenses and/or in the root installation directory of the licensed product(s).

Use, reproduction, transfer, publication or disclosure is prohibited except as specifically provided for in your License Agreement with
Software AG.

Document ID: EXX-EEXXDOTNETWRAPPER-107-20220422



Table of Contents

EntireX .INET WIapper .......cccciiiiiiiiiiiiiiiiccc e \%
1 About this Documentation ...........cc.cocoiiiiiiiiiiiiiii 1
Document CONVeNtioNS ..........ccoiiiiiiiiiiiiiiiiicccce e 2
Online Information and SUPPOTt .......c.ccieiiiiiiiiiii 2
Data Protection .........c..ooooiiiiiiiiiic 3
2 Introduction to the NET Wrapper .........cccccooviiiiiiiiiiiiicc 5
DESCIIPHION ..ttt 6
Generic INET Wrapper Runtime ...........cc.coooiiiiiiiiiiii 7
NET Client Applications ..........ccooviiiiiiiiiiiiiiicicccee 7
INET Server DLL ..o 8
3 Using the NET WIapPer ......c..cciiiiiiiiiiiiiiccecc e 9
Generation Process ...........ccooiiiiiiiiiiiiii 10
Using .NET Wrapper Interactively ...........cccocoviiiiiiiiiii 10
4 Microsoft Visual Studio Wizard for EntireX .NET Wrapper ..........cccccoooviviiiiiiiinnnns 13
Installing the EXteNSION ..........cccoiviiiiiiiiiiiiiiiiiiiccc 14
Using the EXtension ..o 14
Uninstalling the EXtension ..........cccociiiiiiiiiiiiiiiiiiie, 18
5 Using the .NET Wrapper in IDL Compiler Command-line Mode ...............c..cccoene. 19
6 Software AG IDL to .NET Mapping ......cccccecuieviiiiiiiiiiiiiiiieeitcee e 21
Mapping IDL Data Types to .NET Data Types ...........ccccccooieiiiiiiiiiiiiiii 22
Mapping Library Name and Alias ........c..coccooviiiiiiiiiiiiiii 24
Mapping Program Name and Alias .........cccccoeciiiiiiiiiiiiiiiiiiiieiecce 25
Mapping Parameter Names ... 25
Mapping Fixed and Unbounded ATrrays .........ccccociiviiiiiiiiiniiiiiiiiicicciccee e 26
Mapping Groups and Periodic GIoups .........cccocvevuiiiiiiiiiiiiciicccec 26
Mapping STrUCLUTES ........ccccuiiiiiiiiiiiiiiii e 26
Mapping the Direction Attributes In, Out, InOut ............cccocciiiiiiiiniii 27
Mapping the ALIGNED Attribute ..........ccooooiiiiiiii 27
Calling Servers as Procedures or FUNCtioNS ..........c.ccoociiiiiiiiiiiiiiiiiiiiiiceee, 27
7 Writing Applications with the NET Wrapper ...........cccccoviniiiiiiiiiiiicece 29
Writing a Client Application ...........cocciiiiiiiiiiiiiiiiiiiiie e 30
Writing a .NET Server Assembly ..........ccccoooiviiiiiiiiiiiiicc 32
Creating ASPNET Web Services .........cccccceiiiiiiiiiiiiiiiiiiiiiiiicciiccieccecce 32
Using the Broker and RPC User ID/Password ...........cccccoecviiiiiiiiiiiiiiiiiiniiciee 34
USING SSL/TLS ..o 35
Using Internationalization with the INET Wrapper ..........ccccoecevviiniiiniiniininnnnn. 36
8 Configuring a .NET Wrapper Application ..........cccccooiiiiiiiiiiniii, 37
AsSembly VEISIONING .....cccueiiiiiiiiiiiiiiiiiiiciiecceee e 38
Client Configuration ..........cccocciiiiiiiiiiiiiiii 39
Server Configuration ...........c.ccooiiiiiiiiiiiic 43
9 Reliable RPC for INET WIapper .......cccceoiiiiiiiiiiiiiiiciiicicccce e 45
Introduction to Reliable RPC ..........ccoooiiiiiiiiiiiii 46
Writing @ CHENt .......coooiiiiiiiiii e 47




EntireX .NET Wrapper

WIIHING @ SEIVET ..oovvviiiiiiiiiiiiciic 49
Broker Configuration ............c.cocooiiiiiiiiiiiiiicc 49
10 .NET Wrapper Reference ...........cccoccuivuiiiiiiiiiiiiiiiiiiiiiiicic e 51
AHTIDULES oo 52
CIASSES ...vviiviiiiiiiic ittt 54

iv EntireX .NET Wrapper



EntireX .NET Wrapper

The EntireX .NET Wrapper provides access to RPC servers for .NET client applications and access
to .NET servers for any RPC client. The .NET Wrapper generation tools of the Designer take as
input a Software AG IDL file, which describes the interface of the RPC, and generates C# classes
that implement the methods and data types of the interface.

Introduction Introduction to the NET Wrapper.

Using How to use the .NET Wrapper: the generation process; using the
.NET Wrapper interactively

Visual Studio Wizard for NET Using .NET Wrapper with Microsoft Visual Studio Extension.

Wrapper

IDL Compiler Command-line Mode |Using the NET Wrapper in IDL Compiler command-line mode

Mapping Mapping Software AG IDL data types to .NET data types.

Writing Applications Writing a client application with the EntireX .NET Wrapper.

Application Configuration Configuring a .NET Wrapper application.

Reliable RPC Introduction to reliable RPC; writing a client and a server for Reliable

RPC; Broker configuration.

Reference Reference material (attributes and classes).
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

In addition, you can also access the cloud product documentation via https://www.software-
ag.cloud. Navigate to the desired product and then, depending on your solution, go to “Developer
Center”, “User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://knowledge.soft-

wareag.com.
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About this Documentation

Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:

® Browse through our vast knowledge base.

" Ask questions and find answers in our discussion forums.

Get the latest Software AG news and announcements.

Explore our communities.
® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

EntireX .NET Wrapper 3
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Introduction to the .NET Wrapper

Description

The EntireX .NET Wrapper provides access to RPC servers for .NET client applications and access
to .NET servers for any RPC client. The NET Wrapper generation tools of the Designer take as

input a Software AG IDL file, which describes the interface of the RPC, and generates C# classes
that implement the methods and data types of the interface.

EntireX

Servers
Broker

Clients

NET

4,_/./?
Ru'ltll_rne '1——-_,_____‘

-MET-basad L
|

Clients

Servers

-MET-basad L
|

The generated classes can be compiled with the C# compiler into a .NET assembly which can then

be called from any .NET language.

The NET Wrapper works as follows:

® Ct# code is generated from the Software AG IDL file. Using C# is a natural choice when full-
fledged .NET programming is required, since C# was designed for the NET platform.

® The .NET Wrapper runtime implements functionality that is not specific to a given IDL file (e.g.,
marshalling and unmarshalling of data). The generated C# code makes use of the NET Wrapper
runtime functionality. The customer interface and the .NET Wrapper runtime is “managed”.NET
code (C#) and makes use of advanced .NET features such as Attributes, VersionInfo, etc.

® The .NET Wrapper runtime makes use of the functionality of the “unmanaged” RPC C runtime
(dllimport in C#). “Managed”.NET code and “unmanaged” DLL code can be combined safely.

® The Software AG IDL Compiler and an appropriate template are used for the C# code generation.

EntireX .NET Wrapper



Introduction to the .NET Wrapper

Generic .NET Wrapper Runtime

In order to minimize the amount of code generated for a specific IDL, all service-type functionality
required by the client interface object or the server DLL is implemented in a generic .NET Wrapper
runtime SoftwareAG.EntireX.NETWrapper.Runtime.dll. The generic NET Wrapper runtime imple-
ments service classes, i.e.:

® Marshalling .NET data types to Software AG IDL data types

® Unmarshalling Software AG IDL data types to .NET data types

® Connecting to RPC servers via Broker

.NET Client Applications

For a given IDL file, the Software AG IDL Compiler and a C# code generation template for clients
are used to generate a client interface object. The source code generated by the NET Wrapper can
be compiled into a .NET assembly with the C# compiler. Application developers can use the gen-
erated client interface object assembly to write .NET applications that access RPC servers. They
are not limited to C# as programming language. Any .NET programming language based on the
Common Language Runtime (CLR) can make use of the client interface object assembly. Choices
are C#, VisualBasic.NET or managed C++.

DL
.NET Client EntireX
Frogrammer
- g RPC Server
r' >  EntireX - >
JF Broker <
Wrapper (C#)

| Server
NET Wrapper Runtime Implementation
— —T
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Introduction to the .NET Wrapper

.NET Server DLL

The Software AG IDL Compiler and a C# code generation template for servers are used to generate
a C# code frame for a specific IDL. Application developers can use the generated frame to write
their own server code for each program in the IDL. The source code can be compiled into a .NET
assembly (DLL) with the C# compiler. At runtime, RPC clients access the .NET Server assembly
via the RPC Server for .NET.

DL
NET
RPC Server
Programmer
Server Wrapper (C#)
RPC ' > EntireX = > I
Client oy Broker > S
Implemeniaiion’J
L
MET Wrapper Runtime
—
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Using the .NET Wrapper

Generation Process

To generate the C# client or server code, use the Software AG Designer. This can be done interact-
ively with the graphical user interface or in IDL Compiler Command-line Mode.

Using .NET Wrapper Interactively

To use the NET Wrapper functions, open your Eclipse Workspace.
Setting Wrapper Options

Before you start the generation of C# code for the first time, adjust the global options for the NET
Wrapper in the Eclipse preferences under Software AG > EntireX > .NET Wrapper.

On the General tab, set the paths to the Microsoft NET Framework directory and the EntireX
NET Wrapper runtime (SoftwareAG.EntireX.NETWrapper.Runtime.dll). The preferences on the
Generate Client and Generate Server tabs are identical. Choose your default settings for the cli-
ent/server generation.

Option Description

C# compiler options Used to define additional options for the C# compiler (cse.exe).

Project relative output A folder (structure) for C# code generation and compilation relative to the
directory Eclipse project where the IDL file is located.

String handling Default/String/StringBuilder: in the default case, "string" is used for IN and

"StringBuilder" is used for OUT/INOUT parameters. In the case of "String",
the C# type "string" is used for IN/INOUT/OUT. In the case of
"StringBuilder", the C# class "StringBuilder" is used.

Class name prefix for inner | A string is used to prefix the name of the inner classes when the Sanitize
classes option is selected (only necessary for Visual Basic clients).

Use IDL file base name for  |Use this flag only if you have large environments built with previous
output versions of the NET Wrapper. If this flag is set and you have more than
one library in your IDL file, a C# file is generated with the file base name
of the IDL file (base name=file name without extension). If this flag is not
set, the library name is used as file base name for the generated C# file (one
file for every library in the IDL file).

Sanitize If this flag is set, the IDL names are sanitized according to the programming
conventions for C#. See Mapping IDL Data Types to .NET Data Types.

Generate "char" for Al instead | The C# data type "char" is used for IDL parameters of type Al.
of String

Generate "byte" for B1 instead |The C# data type "byte" is used for IDL parameters of type B1.
of byte

10 EntireX .NET Wrapper



Using the .NET Wrapper

Option

Description

Remove trailing blanks

Remove trailing blanks after unmarshalling the data. This flag is useful on
the client side to remove trailing blanks before the data returned from the

server is put into the C# classes string | StringBuilder.

These options are then used as default for the properties of your individual IDL files. You can
change these options (except those on the General tab) for every individual IDL file.

EntireX .NET Wrapper
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Microsoft Visual Studio Wizard for EntireX .NET Wrapper
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Microsoft Visual Studio Wizard for EntireX .NET Wrapper

The Visual Studio Wizard for .NET Wrapper is an extension for Microsoft Visual Studio, which
makes the functionality of the EntireX .NET Wrapper available to Microsoft Visual Studio.

Supported versions of Microsoft Visual Studio and other prerequisites for EntireX components
are described centrally. See Windows Prerequisites.

Installing the Extension

The EntireX .NET Wrapper Wizard Extension for Visual Studio .NET is part of the EntireX install-
ation. After you have installed EntireX, you can find the installer under etc in your EntireX install-
ation path. To install EntireX .NET Wrapper Extension, start EntireX107.vsix and follow the instruc-
tions.

| Note: We recommend you close all other Microsoft applications before installing the exten-

sion.

@ Caution: The installation path mustinclude the bin directory (e.g. C:\ Software AG\ EntireX \bin)

of the corresponding EntireX installation, otherwise the extension will not work properly!

Using the Extension

Once the wizard has been installed, start Microsoft Visual Studio. Start the New Project Wizard
of the Visual Studio and choose EntireX .NET Wrapper Application to start the wizard.

14 EntireX .NET Wrapper



Microsoft Visual Studio Wizard for EntireX .NET Wrapper

Software AG EntireX E I

g software« Welcome to the .NET Wrapper Wizard

Flease gelect pour [DL File

- PrDiECt Name: IEHamplEEllent

Project Path: IE:'\D ocumentz and Settingzhbfty DocumentzYYizual Studio 20084Froject

Broker/Service
MET “Wirapper Buntime Path

F t
AAMELEL | C:AS oftwaredlG\E ntiredd\bin

Software &G 1DL
IE:'\S oftwaredG5E ntirekhexamples\RPC\baszichexampleexample.idl

generate
’7 {* Cliert = Server

Finizh Cancel

First enter the name of a Software AG IDL file in the opening window. You can select whatever
you want to generate client or server code. The project name will be set to IDLNameClient or
IDLNameServer automatically. You can enter the name of the path of the NET Wrapper Runtime
DLL if it is not located in the default path.

EntireX .NET Wrapper 15



Microsoft Visual Studio Wizard for EntireX .NET Wrapper

Software AG Entirexl

Software 4G [DL File

Parameters

g software« Welcome to the .NET Wrapper Wizard

Incheck "use BrokerdServices defaultz" to edit Broker and Service

Clear text Pazzwards [if checked] are included in generated code.

[~ {lze Broker/Services defaults

Host:Part
Broker Uzer

Braoker Faszwaord

[localhost: 15971
[MET-USER

|<n|:|t zpecified: [ usein generated code

Clazz/Server/Service ||:||:-|:,.'5 BY1/CALLMAT

Library M arme
Service User

Service Pazsword

[MET-USER

|<n|:|t zpecified: [ use in generated code

parameters,

Finizh

Cancel

On the page Broker/Service you can change the default settings for Broker and Service.

16
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Microsoft Visual Studio Wizard for EntireX .NET Wrapper

Software AG Entirexl

Software 4G [DL File
¥ Sanitize C#

Broker/Service [~ Generate 'char for &1 instead of 'sting'

_ [ Generate 'byte’ for B instead of "byte]]

[T Remove trailing blanks [ 2% K KW

String handling IDefault j

clazs name prefix for inner clazzes I

Finizh

g software« Welcome to the .NET Wrapper Wizard

S anitize CH Code: Proper caze for clazs and parameter names. Mested group
declarationz are prefiked if unchecked.

Cancel

On the parameters page you can select the options Sanitize and char/string support.

For more information on Broker/Service and parameters, see the EntireX .NET Wrapper document-

ation.

When all data has been entered, click the button Finish. A new Visual Studio .NET solution will
be generated which includes a project with the name IDLNameClient or IDLNameServer. This project

contains the Software AG IDL file, the generated .cs file C# file) and references to the System.dll

and the EntireX.NetWrapper.Runtime.dll.

The project will generate a class library (DLL), which can be used in any other .NET project C# or
VB.NET). For this purpose an additional App.config file is generated which can be used in a project
where an .exe file is generated. The App.config file contains information about Broker, Services etc.

@  Caution: Any changes to the Software AG IDL file will trigger the EntireX extension after

saving. The .cs file will be re-generated and all specifications you made during the imple-

mentation will be lost.

EntireX .NET Wrapper
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Microsoft Visual Studio Wizard for EntireX .NET Wrapper

Uninstalling the Extension

Uninstalling an extension is now part of the Visual Studio itself.

~ To uninstall the extension EntireX .NET Wrapper Application

s From the Tools menu, choose Extensions and Updates (VS2017) or Manage Extensions
(VS2019).

The EntireX .NET Wrapper Wizard Extension for Visual Studio will be removed from your com-
puter.

| Note: The extension must be uninstalled before you uninstall EntireX, otherwise the uninstall
of EntireX will fail.
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5 Using the .NET Wrapper in IDL Compiler Command-line
Mode

The table below shows the command-line options for the .NET Wrapper if the IDL Compiler is
used. Options can be valid for client and server side.

Reg/
Option Opt |Description
-D BROKER=nnn R |The EntireX Broker.
-D SERVICE=nnn R |The EntireX Service.
-t nnn R |Template for client (csharp_client.tpl) or server generation

(csharp_server.tpl).

-0 nnn R |Project relative output directory or absolute Path

-D O |String handling (Default if omitted).
ATOSTRING=String|StringBuilder

-D CLASSNAMEPREFIX=nnn O |Class name prefix for inner classes.

-D A1TOCHAR=n O |Generate "char" for Al instead of String (1 if required).
-D BITOBYTE=n O |Generate "byte" for Bl instead of byte (1 if required).
-D TRIM=n O |Remove trailing blanks (1 if required).

-PSANITIZE O |Sanitize.

-F nnn O |File base name for output.

See also Starting the IDL Compiler and IDL Compiler Usage Examples.
Example

To start the IDL Compiler with the parameters for the interface object generation, enter, for example
the following in a single command line:

19



Using the .NET Wrapper in IDL Compiler Command-line Mode

java -classpath "$EXXDIR\..\common\Tib\saglic.jar;"%ProgramFiles%\Software
AG\EntireX\Classes\exxidlcompiler.jar" -Dsagcommon="%CommonProgramFiles%\Software
AG" com\softwareag\entirex\idlcompiler\TpIParser -PSANITIZE -D BROKER="Tocalhost:1971"
-D SERVICE="RPC/SRV1/CALLNAT" -t "%ProgramFiles%\Software
AG\EntireX\Template\csharp_client.tpl" -F example -o NET example.id]

The client interface object is generated in the subdirectory NET.

Status and processing messages are written to standard output (stdout), which is normally set to
the executing shell window.

20 EntireX .NET Wrapper



6 Software AG IDL to .NET Mapping

Mapping IDL Data Types t0 .NET Data TYPES ....coovveiiiiiieee ettt
Mapping Library Name and Alias ..............
Mapping Program Name and Alias ............
Mapping Parameter Names .....................
Mapping Fixed and Unbounded Arrays ......
Mapping Groups and Periodic Groups .......
Mapping Structures ...........ccccoeevvvvvveeennn.

= Mapping the Direction Attributes In, OuUt, INOUL ..........oiiiiii e

= Mapping the ALIGNED Attribute ...............

= Calling Servers as Procedures or Functions
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Software AG IDL to .NET Mapping

Mapping IDL Data Types to .NET Data Types

In the table below, the following metasymbols and informal terms are used for the IDL.

® The metasymbols "[" and "]" enclose optional lexical entities.

® The informal term number (or in some cases numberl.number?)is a sequence of numeric characters,
for example 123.

Software AG IDL Description .NET Data Types Note
Al Alphanumeric charor String/StringBuilder|l,5
Anumber Alphanumeric String/StringBuilder 1
AV Alphanumeric variable length String/StringBuilder 1
AV[number] Alphanumeric variable length with String/StringBuilder 1
maximum length
B1 Binary byteorbytel] 6
Bnumber Binary bytel]
BV Binary variable length bytel] 2
BV number] Binary variable length with maximum |byte[l]
length
D Date DateTime 3,7
Fa4 Floating point (small) float
F8 Floating point (large) double
I1 Integer (small) sbyte
12 Integer (medium) short
14 Integer (large) int
Knumber Kanji String/StringBuilder 1
KV Kanji variable length String/StringBuilder 1
KV number] Kanji variable length with maximum |String/StringBuilder 1
length
L Logical bool
NnumberlIl.numberZ] |Unpacked decimal BigNumeric 9,10
decimal 8,10
NUnumberlIl.number2]|Unpacked decimal unsigned BigNumeric 9,10
decimal 8,10
Pnumberll .number?] |Packed decimal BigNumeric 9,10
decimal 8,10
PUnumberll.numberZ2]|Packed decimal unsigned BigNumeric 9,10

22 EntireX .NET Wrapper



Software AG IDL to .NET Mapping

Software AG IDL Description .NET Data Types Note
decimal 8,10
Time DateTime 47

] Notes:

. System.String for direction in, otherwise System.Text.StringBuilder if Default is used for
parameter ATOSTRING. If Stringisused for ATOSTRING, System.Stringisused everywhere, and
if StringBuilder isused for ATOSTRING, System.Text.StringBuilder is used everywhere. See
Using the NET Wrapper.

. Unsigned integer ranging from 0 to 255.

. Count of days AD (anno domini, after the birth of Christ). The valid range is from 1.1.0001 up
to 28.11.2737 (only the date part of DateTime is used).

. Count of tenths of a second AD (Anno Domini, after the birth of Christ). The valid range is from
1.1.0001 00:00:00.0 up to 16.11.3168 09:46:39 plus 0.9 seconds.

. If -D AITOCHAR=1 is defined in the erxid1 call, Al is mapped to char, otherwise to
String/StringBuilder.

. If -D B1TOBYTE=1 is defined in the erxid1 call, B1 is mapped to byte, otherwise to byte[].

. The Natural DATE type allows for the value 01.01.0000 to denote an undefined date. In order to
avoid the .NET runtime throwing an exception when attempting to assign the invalid date
value 01.01.0000 to a .NET DateTime variable, the NET runtime converts an incoming neutral
date/time value 01.01.0000 00:00:00.0 into the special NET DateTime value DateTime.MaxValue
- 1 tick (that is 31.12.9999:23:59:59.9999998). When this value is passed to the EntireX runtime
to be sent to an EntireX RPC service, it is converted back into the neutral RPC date/time value
01.01.0000 00:00:00.0.

. If the total number of digits (numberI+number?) is equal to or lower than 28, mapping is to the
.NET data type decimal.

. If the total number of digits (numberl+number?) is greater than 28, mapping is to the .NET class
BigNumeric. See BighNumeric under .NET Wrapper Reference.

10. If you connect two endpoints, the total number of digits used must be lower or equal than the
maxima of both endpoints. For the supported total number of digits for endpoints, see the notes
under data types N, NU, P and PU in section Mapping IDL Data Types in the respective Wrapper
or language-specific documentation.

See also hints and restrictions on the Software AG IDL data types valid for all programming lan-
guage bindings under IDL Data Types in the IDL Editor documentation.

EntireX .NET Wrapper 23



Software AG IDL to .NET Mapping

Mapping Library Name and Alias

The library name as specified in the IDL file is sent from a client to the server. Special characters
are not replaced. The library alias is not sent to the server.

In the RPC server, the IDL library name sent may be used to locate the target server. See Locating
and Calling the Target Server under z/OS (CICS, Batch, IMS) | C | .NET | BS2000 in the respective
Administration or RPC Server documentation.

The library name as given in the IDL file is used to compose the names of the generated output
files. See 1ibrary-definition under Software AG IDL Grammar in the IDL Editor documentation.
Therefore the allowed characters are restricted by the underlying file system. The name is composed
from <7Tibrary-name>.id1 to<Ilibrary-name>.cs as default. The name of the client stub file can
be changed by using the -F option of the erxidl command. See Using the NET Wrapper in IDL
Compiler Command-line Mode.

In accordance with the C# conventions, the class name is built as follows with the default setting
-PSANITIZE:

® The initial character and characters following one of the special characters '#, '$', '&', '+, -, '_/,

e o

.,/ and '@ are converted to uppercase.

= All other characters are converted to lowercase.

LI T T T B I B}

® The special characters '#', '$', '&', '+, '-','_", ", '/' and '@" are removed.

Other special characters used in the library name are not changed and may lead to problems with
your underlying file system and to compile errors.

If there is an alias for the library name in the 1ibrary-definition, this alias is used “as is” to form
the class name. Therefore, this alias must be a valid C# class name.

Examples:
MY-CLASS toMyClass (class)

MY-CLASS alias YOUR_CLASS to YOUR_CLASS(class)
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Mapping Program Name and Alias

The program name is sent from a client to the server. Special characters are not replaced. The
program alias is not sent to the server.

In the RPC server, the IDL program name sent is used to locate the target server. See Locating and
Calling the Target Server under z/OS (CICS, Batch, IMS) | C | .NET | BS2000 in the respective Ad-
ministration or RPC Server documentation.

The program names as given in the IDL file are mapped to methods within the generated C#
sources. See program-definitionunder Software AG IDL Grammar in the IDL Editor documentation.

In accordance with the C# conventions method names are built as follows with the default setting
-PSANITIZE:

* Characters are converted to lowercase with the following exceptions
® The special characters '#','$', '&', '+','-,'_", ", /" and '@ are removed
* The character following one of the special characters is converted to uppercase.

Other special characters used in the program name are not changed and may lead to compile errors.

If there is an alias for the program name in the program-definition under Software AG IDL
Grammar in the IDL Editor documentation, this alias is used “as is” for the method name. Therefore,
this alias must be a valid C# method name.

Examples:
MY -PROGRAM to MyProgram (method).

MY-PROGRAM aTias YOUR_PROGRAM to YOUR_PROGRAM(method).

Mapping Parameter Names

The parameter names as given in the parameter-data-definition of the IDL file are mapped to
parameters of the generated C# methods.

In accordance with the C# conventions the parameter names are built as follows with the default
setting -PSANITIZE:
® Characters are converted to lowercase except

® The special characters '#,'$', '&','+','-,"_, ", /' and '@" are removed

® The character following one of those special characters is converted to uppercase.
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IDL files that use C# keywords (e.g. string or float) as parameter names are not supported. Do
not use C# keywords such as string or float as parameter names. Modify your IDL file accord-

ingly.
Example:

MY -PARAM to myParam (parameter)

Mapping Fixed and Unbounded Arrays

Arrays in the IDL file are mapped to C# arrays. If an array value does not have the correct number
of dimensions or elements, this will result in an exception. If the value nu11 (null pointer) is used
as an input parameter (for IN and INOUT parameters), an array will be instantiated by the runtime.

Mapping Groups and Periodic Groups

Groups in the IDL file are mapped to C# classes.

The namespace for group classesis SoftwareAG.EntireX.NETWrapper.Generated. filename.Groups
on the client side, and SoftwareAG.EntireX.NETWrapper.Server.libraryname.Groups on the
server side.

Mapping Structures

Structures in the IDL file are mapped to C# classes.

The namespace for structure classes is
SoftwareAG.EntireX.NETWrapper.Generated. filename.Structs on the client side, and
SoftwareAG.EntireX.NETWrapper.Server.libraryname.Structs on the server side.

See Mapping Groups and Periodic Groups.
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Mapping the Direction Attributes In, Out, InOut

" IN parameters are implemented as normal parameters of the generated C# class method.
" OUT parameters are implemented as out parameters of the generated C# class method.

" INOUT parameters are implemented as ref parameters of the generated method.

Note that only the direction information of the top-level fields (level 1) is relevant. Group fields
always inherit the specification from their parent. A different specification is ignored.

See attribute-11ist under Software AG IDL Grammar in the IDL Editor documentation for the
syntax on how to describe attributes within the IDL file and refer to the direction attribute.

Mapping the ALIGNED Attribute

Not supported.

Calling Servers as Procedures or Functions

The IDL syntax allows definitions of procedures only. It does not have the concept of a function.
A function is a procedure which, in addition to the parameters, returns a value. Procedures and
functions are transparent between clients and servers, that is, a client using a function can call a
server implemented as a procedure and vice versa.

In C# a procedure corresponds to a method with result type void, a function returns a value of
some type.

It is possible to treat an OUT parameter of a procedure as the return value of a function. The .NET
Wrapper generates a method with a non-void result type when the following two conditions are
met:

" the last parameter of the procedure definition is of type 0UT

* this last parameter of the procedure definition has the name Function_Result

In this case no function parameter is generated for this OUT parameter.
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= Writing a Client Application ...........ccccccceeeeiis
= Writing a .NET Server Assembly ......................
= Creating ASP.NET Web Services ............c...o...
= Using the Broker and RPC User ID/Password ...
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= Using Internationalization with the .NET Wrapper
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Writing a Client Application

= Required Steps

= Creating a Microsoft Visual Studio Solution

= Creating the .NET Wrapper Client Stub Library (Assembly)
= Creating the .NET Wrapper Client Application

Required Steps

Writing a client application with the EntireX .NET Wrapper typically requires the following steps:

Starting from an IDL file, generate a C# client interface object as described under Using the NET
Wrapper. From the context menu of the IDL file, choose Other > Generate NET > RPC Client.

As an alternative, use the Microsoft Visual Studio Wizard for EntireX .NET Wrapper. Both ap-
proaches generate C# sources from an IDL file. If there is a related server mapping file (Natural |

COBOL), this is also used (internally).

Create a Visual Studio Solution. See Creating a Microsoft Visual Studio Solution.

Build a .NET assembly from the generated C# client interface object. See Creating the NET
Wrapper Client Stub Library (Assembly).

Create an application that uses the generated client interface object assembly and the .NET
Wrapper runtime SoftwareAG.EntireX.NETWrapper.Runtime.dll. See Creating the NET Wrapper
Client Application.

The following description outlines as an example the steps required to build a .NET Wrapper client
application (solution) with the Microsoft Visual Studio.

Creating a Microsoft Visual Studio Solution

1.

Start Microsoft Visual Studio.

2. From the File menu, choose New > Blank Solution.... and choose an appropriate name for the

solution.

Creating the .NET Wrapper Client Stub Library (Assembly)

. Select the solution and choose Add, choose New Project.

In the New Project dialog, choose Visual C# Projects and Class Library. Choose an appropriate
name for the class library, e.g. "exampleClientStub".

Delete the default class file Class1.cs.

Select the new project and choose Add > Add Existing Item and add the example.cs file generated
previously.
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5. Select References, choose Add Reference and add the .NET Wrapper runtime SoftwareAG.En-
tireX.NETWrapper.Runtime.dll.

. Note: Make sure the property CopylLocal is not set to true in the properties of the refer-
enced assembly.

6. Build the class library.
Creating the .NET Wrapper Client Application

1. Add anew project to the solution: Choose the solution, Add, New Project..., Visual C# Projects,
Console Application. Choose an appropriate name for the project, for example, "exampleClient".

2. Rename the default class file Class1.cs as appropriate.

3. Choose References > Add Reference and add the .NET Wrapper runtime SoftwareAG.En-
tireX.NETWrapper.Runtime.dIl.

4. Choose References > Add Reference > Projects and add the NET Wrapper client interface object
exampleClientStub.

5. Now implement your client application. Add the following lines to the top of the class file:

using SoftwareAG.EntireX.NETWrapper.Runtime;
using SoftwareAG.EntireX.NETWrapper.Generated.example;

6. In a method of the application class implement the connection to an EntireX Broker, for example:

Broker broker = new Broker("localhost:1971", "ERX-USER");
broker.Logon("ERX-PASS");

and an EntireX RPC service, for example:

Service service = new Service(broker, "RPC/SRV1/CALLNAT", "EXAMPLE");
service.UserIDAndPassword("RPC-USER", "RPC-PASSWORD");

7. The example class can now be instantiated, for example:

Example e = new Example( service );

and the example methods called, for example:
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int result = ex.Calculator( "+", 10, 15);

Writing a .NET Server Assembly

Writing a .NET server assembly with the EntireX .NET Wrapper typically requires the following
steps:

" Generate a Ct file as described under Using the .NET Wrapper. From the context menu of the
IDL file, choose Other > Generate NET > RPC Server. As an alternative, use the Microsoft
Visual Studio Wizard for EntireX .NET Wrapper.

® Insert your server-specific code at the required positions (C# methods).

® Build a .NET Server assembly (DLL) from the generated C# file, following the rules for building
a client stub library with the Microsoft Visual Studio.

® Make the .NET Server assembly available to the RPC Server for .NET, see Locating and Calling
the Target Server in the RPC Server for .NET documentation.

* To start, stop and configure the RPC Server for .NET to suit your needs, see Administering the
RPC Server for NET in the RPC Server for NET documentation.

Creating ASP.NET Web Services

The generated C# client interface object can be used in an ASP.NET Web service to publish EntireX
RPC services as Web services. With Visual Studio you can easily create an ASP.NET Web service
that publishes methods of the EntireX RPC service (or your own methods that just use the EntireX
RPC service).

| Note: The NET Wrapper Runtime uses unmanaged DLLs. For this reason, ASP.NET applic-

ations have to run in full-trust mode.
Example

You have built the .NET Wrapper example EntireX \examples\ RPC\dotNetClient as described in
the README file.

Then create a new “ASP.NET Web service” project with references to the generated client interface
object and the .NET Wrapper runtime.

You can use the following example code (in the .asmx file) to implement a Web method add that
exposes the calc method of the example.
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using System;

using System.Collections;

using System.ComponentModel;

using System.Data;

using System.Diagnostics;

using System.Web;

using System.Web.Services;

using System.Text;

using SoftwareAG.EntireX.NETWrapper.Runtime;

using SoftwareAG.EntireX.NETWrapper.Generated.example;

namespace WebServicel

{

/// <summary>

/// Summary description for Servicel.

/// </summary>

public class Servicel : System.Web.Services.WebService
{

public Servicel()

{

//CODEGEN: This call is required by the ASP.NET Web Services Designer
InitializeComponent();

}

f#iregion Component Designer generated code

//Required by the Web Services Designer
private IContainer components = null;

/// <summary>

/// Required method for Designer support - do not modify
/// the contents of this method with the code editor.
/// </summary>

private void InitializeComponent()

{

}

/// <summary>

/// Clean up any resources being used.
/// </summary>

protected override void Dispose( bool disposing )
{

if(disposing && components != null)

{

components.Dispose();

}

pase.Dispose(disposing);

}

ffendregion

// WEB SERVICE EXAMPLE
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[WebMethod]
public int add(int suml, int sum2)
{
Example e = new Example();

int result = e.calc("+", suml,sum?2);
return result;

}

}

}

Using the Broker and RPC User ID/Password

EntireX supports two user ID/password pairs: a broker user ID/password pair and an (optional)
RPC user ID/password pair sent from RPC clients to RPC servers. With EntireX Security, the broker
user ID/password pair can be checked for authentication and authorization.

The RPC user ID/password pair is designed to be used by the receiving RPC server. This compon-
ent's configuration determines whether the pair is considered or not. Useful scenarios are:

® Credentials for Natural Security

® Impersonation in the respective RPC Server documentation

" Web Service Transport Security with the RPC Server for XML/SOAP, see XML Mapping Files

" Service execution with client credentials for EntireX Adapter Listeners, see Configuring Listeners
" etc.

Sending the RPC user ID/password pair needs to be explicitly enabled by the RPC client. If it is

enabled but no RPC user ID/password pair is provided, the broker user ID/password pair is inher-
ited to the RPC user ID/password pair.

With the property NaturallLogon (see below) sending the RPC user ID/password pair is enabled
for the Java RPC clients. If you do so, we strongly recommend using SSL/TLS. See Using SSL/TLS.

~ To use the broker and RPC user ID/password

1  Specity a broker user ID and broker password using the constructor and methods of class
Broker.

2 Set the property Naturallogon of class Service to true to enable sending the RPC user
ID/password pair.

3  If different user IDs and/or passwords are used for broker and RPC, use the methods and
properties offered by class Service to provide a different RPC user ID/password pair.
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4 By default the library name sent to the RPC server is retrieved from the IDL file (see
Tibrary-definitionunder Software AG IDL Grammar in the IDL Editor documentation). The
library name can be overwritten. This is useful if communicating with a Natural RPC server.
Specify a library in the property Library of class Service.

Using SSL/TLS

RPC client applications can use Secure Sockets Layer/Transport Layer Security (SSL/TLS) as the
transport medium. The term “SSL” in this section refers to both SSL and TLS. RPC-based clients
are always SSL clients. The SSL server can be either the EntireX Broker or Direct RPC in webMethods
Integration Server (IS inbound). For an introduction see SSL/TLS, HTTP(S), and Certificates with
EntireX in the platform-independent Administration documentation.

With the .NET Wrapper, the SSL parameters (e.g. certificates) are appended to the Broker ID,
separated by a question mark (?). See URL-style Broker ID under EntireX RPC Programming.

> To use SSL

1  To operate with SSL, certificates need to be provided and maintained. Depending on the
platform, Software AG provides default certificates, but we strongly recommend that you
create your own. See SSL/TLS Sample Certificates Delivered with EntireX in the EntireX Security
documentation.

2 Specify the Broker ID using URL style, for example:

ssl://localhost:2010

If no port number is specified, port 1958 is used as default.

3  Specify SSL parameters, for example:

"VERIFY_SERVER=N&TRUST_STORE=c:\\certs\\CaCert.pem"

If the SSL client checks the validity of the SSL server only, this is known as one-way SSL. The
mandatory trust_store parameter specifies the file name of a keystore that must contain the
list of trusted certificate authorities for the certificate of the SSL server. By default a check is
made that the certificate of the SSL server is issued for the hostname specified in the Broker
ID. The common name of the subject entry in the server's certificate is checked against the
hostname. If they do not match, the connection will be refused. You can disable this check
with SSL parameter verify_server=no.

If the SSL server additionally checks the identity of the SSL client, this is known as two-way
SSL. In this case the SSL server requests a client certificate (the parameter verify_client=yes
is defined in the configuration of the SSL server). Two additional SSL parameters must be
specified on the SSL client side: key_store and key_passwd. This keystore must contain the
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private key of the SSL client. The password that protects the private key is specified with
key_passwd.

The ampersand (&) character cannot appear in the password.

SSL parameters are separated by ampersand (&). See also SSL/TLS Parameters for SSL Clients.

4  Make sure the SSL server to which the .NET client connects is prepared for SSL connections
as well. The SSL server can be EntireX Broker or Direct RPC. See Running Broker with SSL/TLS
Transport in the platform-specific Administration documentation.

Using Internationalization with the .NET Wrapper

RPC clients generated with the NET Wrapper use by default the “current locale” encoding set up
on the Windows system for converting UNICODE (UTF-16) representations of strings to single-

byte or multibyte representations that are sent to the Broker, and vice versa. The codepage name
is also transferred to tell the broker the encoding of the data. If you want to adapt the locale settings
of your Windows system, use the Regional and Language Options in the Windows Control Panel.

The Broker class of the .NET Wrapper Runtime makes use of the .NET Framework class
System.Text.Encoding for character conversion.

Refer also to the .NET Framework class library documentation for System.Text.Encoding.

The CharacterEncoding property of the Broker class that guides the character conversion is initial-
ized with System.Text.Encoding.GetEncoding(0) (current locale). The application programmer
can also assign a custom encoding object to the Broker class's CharacterEncoding property for
custom character conversions. If an encoding object is provided, the corresponding codepage is
transferred to the Broker instead of the default Windows locale.

Enable character conversion in the broker by setting the service-specific attribute CONVERSION to
"SAGTRPC". See also Configuring ICU Conversion under Configuring Broker for Internationalization in
the platform-specific Administration documentation. More information can be found under Inter-
nationalization with EntireX.
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Most applications require some configuration parameters that represent durable applications or
user preferences.

The .NET framework includes configuration functionality that loads an application's configuration
automatically at runtime without programmer intervention. For a standalone application, named,
for example, myapp.exe you must name the configuration file (containing configuration settings in
a given XML format) myapp.exe.config. The framework will then be able to load and parse the
configuration file automatically when myapp.exe is run. For an ASPNET Web application the
configuration file is named web.config.

Assembly Versioning

.NET Framework assemblies support a strong versioning concept. The specific version of an as-
sembly and the versions of dependent assemblies are recorded in the assembly's manifest. The
versions of the dependent assemblies to be loaded at runtime are determined depending on the
version policy in effect.

The default version policy is that applications run only with the exact versions of dependent as-
semblies they were built with. Thus applications that are deployed together with their dependent
assemblies are not affected by newer or older versions of some of these assemblies. However, it
is sometimes desirable to update an assembly with a newer version. In order to make this possible,
the default version policy can be overridden by explicit version policies specified in configuration
files, for example, the application configuration file (<appname>.exe.config or web.config for Web
applications).

The following example shows a configuration file fragment that, when placed in a standalone
application's <appname>.exe.config file or a Web application's web.config file, directs the NET
runtime loader to load version 10.7.0.0 of the NET Wrapper runtime whenever earlier versions
in the range 7.1.1.0-7.2.1.73 are required.

<runtime>
<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1l">
<dependentAssembly>
<assemblyldentity name="SoftwareAG.EntireX.NETWrapper.Runtime"
publicKeyToken="645917c53ee5c617" />
<bindingRedirect oldVersion="7.1.1.0-7.2.1.73" newVersion="10.7.0.0" />
<codeBase version="10.7.0.0"
-
href="file:///C:\SoftwareAG\EntireX\bin\SoftwareAG.EntireX.NETWrapper.Runtime.d11"/>
</dependentAssembly>
</assemblyBinding>
</runtime>

Notes:

38 EntireX .NET Wrapper



Configuring a .NET Wrapper Application

1. After installation you will find the NET Wrapper Runtime at the following locations:
= <inst_root>\ EntireX \ bin (64-bit)
= <inst_root>\ EntireX \bin \x86 (32-bit)

2. The runtime configuration fragment must come after the configSections and appSettings
sections of the configuration file, otherwise the .NET Wrapper Runtime will report errors.

See also the Microsoft .NET Framework documentation on assembly versioning.

Client Configuration

The NET Wrapper Runtime supports the NET framework configuration mechanism for several
EntireX Broker and (RPC) Service class properties. By making use of this configuration mechanism,
NET Wrapper client applications can avoid constructing Broker and Service objects explicitly and
leave this task to the NET Wrapper Runtime.

There is one section group named EntireX with the two sections Broker and Service where you
can specify the settings for EntireX .NET Wrapper Broker and Service class instances respectively.
This section covers the following topics:

= Example

= Broker Configuration Section

= Broker Configuration Example

= Service Configuration Section

= Service Configuration Example
= |nstallation Configuration Section
= Sample Configuration File

Example

<sectionGroup name="EntireX"> <I-- EntireX Configuration Section Group <
Definition -->
<section name="Broker" type="System.Configuration.NameValueSectionHandler" />
<{section name="Service" type="System.Configuration.NameValueSectionHandler" />
<section name="Installation" <«
type="System.Configuration.NameValueSectionHandler" />
<{/sectionGroup>
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Broker Configuration Section

If the default constructor Broker() is used to construct a Broker object, i.e. if there is no Broker
name (or Broker ID) supplied, then the application's configuration file is examined for configuration
settings to be taken as values. If no entry is found for a given setting name, the default values listed
in the table below will apply.

The following can be configured for Broker instances:

Key Description

name Specifies the Broker name (or Broker ID). The default value is "localhost:1971". Only the
URL-style Broker ID is supported. For secured brokers, the host name starts with
"ssl://...". See Examples.

userID Specifies the user ID to be used to connect to the Broker;

The default value is "NET-USER".

password Specifies the password to be used to connect to the Broker. This setting is only considered
when userID is also specified.
The default value is "NET-PASS".

securedPassword |The password will be encrypted when the application is started and will be replaced
by a secure password in the configuration file. This secured password is re-generated
every time the password is specified again.

compression Specifies whether the data sent to the Broker should be compressed.
Possible values are:

= NO_COMPRESSION (CompressionLevel=0)
® BEST_COMPRESSION (CompressionLevel=9)

= DEFAULT_COMPRESSION (CompressionLevel=6)
this.compression=Compression. DEFAULT_COMPRESSION;

BEST_SPEED (CompressionLevel=1)
DEFLATED (CompressionLevel=8)

The default value is NO_COMPRESSION. Use either Compression or CompressionLevel.

compressionLevel |Specifies what compression level should be used.
Possible values are in the range 0 to 9 (see CompressionLevel property in the Broker
class). Use either Compression or CompressionLevel.

forceLogon Specifies whether a forceLogon should be performed.
Possible values are "true" and "false".
The default value is "false".

For details see FORCE - LOGON under Writing Applications using EntireX Security.

token Specifies a token value to be used in conjunction with the user ID.

"

The default value is "".
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Broker Configuration Example

<{Broker>
{!-- EntireX Broker Configuration -->
<add key="name" value="Tlocalhost:1971" />
<add key="userID" value="NET-USER" />
<add key="password" value="NET-PASS" />
<add key="compression" value="NO_COMPRESSION" />
<add key="forcelLogon" value="false" />
<add key="token" value="top secret" />
</Broker>

Service Configuration Section

If the default constructor Service() is used to construct a Service object, i.e. there is no Service name
(class/server/service) supplied, then the application's configuration file is examined for configuration
settings to be taken as values. If no entry is found for a given setting name, then the default values
apply as listed below.

The following can be configured for Service instances.

Key Description

name Specifies the name of the service.
Default value is "RPC/SRV1/CALLNAT".

naturalLogon Specifies whether a Natural logon should be performed.
Possible values are "true" and "false".
The default value is "false".

userID Specifies the user ID to be used to connect to the RPC Server.

password Specifies a password to be used to connect to the RPC Server. This setting is only
considered when userID is also specified.

securedPassword | The password will be encrypted when the application is started and will be replaced by
a secure password in the configuration file. This secured password is re-generated every
time the password is specified again.

timeout Sets or retrieves the timeout value for a given Service instance. timeout = 0isinvalid.
If 0 is set, a default of 50 seconds will be used.

encoding Define an encoding for character translation. Default is

System.Text.Encoding.GetEncoding(0) (current locale). See also the NET
Framework class library documentation for System. Text.Encoding.

EntireX .NET Wrapper 41



Configuring a .NET Wrapper Application

Service Configuration Example

{Service>
{l-- EntireX Service Configuration -->
<add key="name" value="RPC/SRV1/CALLNAT" />
<add key="libraryName" value="" />
<add key="naturallogon" value="false" />
<add key="timeout" value="100" />
<add key="encoding" value="is0-8859-1" />

<{/Service>

Installation Configuration Section

Key |Description

bindir|bin folder of the EntireX installation.

Use this section only if there are problems loading the .NET runtime, particularly in ASPNET
environments. Under normal circumstances, adding the runtime section to the config file should
solve the problem. This section should be used only as a quick workaround in development envir-
onments.

Sample Configuration File

<?xml version="1.0" encoding="utf-8" ?>
<configuration>
<configSections>
<sectionGroup name="EntireX"> <!-- EntireX Configuration Section Group <
Definition -->
<{section name="Broker" type="System.Configuration.NameValueSectionHandler" />
<section name="Service" type="System.Configuration.NameValueSectionHandler" />
</sectionGroup>
<{/configSections>

<EntireX>
{l-- EntireX Configuration Section -->
<Broker>
<I-- EntireX Broker Configuration -->
<add key="name" value="Tlocalhost:1971" />
<add key="userID" value="NET-USER" />
<add key="password" value="NET-PASS" />
<add key="compression" value="NO_COMPRESSION" />
<add key="forcelLogon" value="false" />
<add key="token" value="top secret" />
</Broker>
<Service>
{!-- EntireX Service Configuration -->
<add key="name" value="RPC/SRV1/CALLNAT" />
<add key="libraryName" value="" />
<add key="naturallogon" value="false" />
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</Service>
</EntireX>
<appSettings>
<!I-- other app settings go here -->
</appSettings>
</configuration>

Server Configuration

Configuring a .NET Server assembly is described under Locating and Calling the Target Server in
the RPC Server for .NET documentation. See also Writing a .NET Server Assembly.
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Introduction to Reliable RPC

In the architecture of modern e-business applications (such as SOA), loosely coupled systems are
becoming more and more important. Reliable messaging is one important technology for this type
of system.

Reliable RPC is the EntireX implementation of a reliable messaging system. It combines EntireX
RPC technology and persistence, which is implemented with units of work (UOWs).

Reliable RPC allows asynchronous calls (“fire and forget”)

Reliable RPC is supported by most EntireX wrappers

Reliable RPC messages are stored in the Broker's persistent store until a server is available

Reliable RPC clients are able to request the status of the messages they have sent

Persistent
Store

.‘ [

RPC
with UOW : v

RPC | EntireX
Client < Broker

Error Status
RFC
with UOW

b

RPC
Server

Reliable RPC is used to send messages to a persisted Broker service. The messages are described
by an IDL program that contains only IN parameters. The client interface object and the server
interface object are generated from this IDL file, using the EntireX .NET Wrapper.

Reliable RPC is enabled at runtime. The client has to set one of two different modes before issuing
a reliable RPC request:

= AUTO_COMMIT
" CLIENT_COMMIT
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While AUTO_COMMIT commits each RPC message implicitly after sending it, a series of RPC messages
sent in a unit of work (UOW) can be committed or rolled back explicitly using CLIENT_COMMIT
mode.

The server is implemented and configured in the same way as for normal RPC.

Writing a Client

All methods for reliable RPC are available on the service class object. See description of class
Service for details. The methods are:

= Service.SetReliableState

" Service.getReliableState

Service.ReliableCommit
Service.ReliableRollback
Service.GetReliableld
Service.GetReliableStatus

Example:

Create Broker object and interface object.

Mail mail = new Mail();
mail.service.broker.logon();

Enable reliable RPC with CLIENT_COMMIT:

mail.SetReliableState(Service.ReliableState. RELIABLE_AUTO_COMMIT) ;

The first RPC message.

mail.Sendmail("mail receiver", "subject 1", "Text 1");

Check the status: get the message ID first and use it to retrieve the status.

StringBuilder reliableID = new StringBuilder();
StringBuilder reliableStatus = new StringBuilder();

mail.service.GetReliablelD(ref reliablelD);
mail.service.GetReliableStatus(reliablelID, ref reliableStatus);

Console.Out.WriteLine("Reliable ID = " + reliableID.ToString());
Console.Qut.WritelLine("Reliable Status = " + reliableStatus.ToString());
The second RPC message.
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mail.Sendmail("mail receiver", "subject 2", "Text 2");

Commit the two messages.

mail.service.ReliableCommit();

Check the status again for the same message ID.

mail.service.GetReliableStatus(reliablelID, ref reliableStatus);

Console.Out.WritelLine("Reliable ID = " + reliablelID.ToString());
Console.Out.WritelLine("Reliable Status = " + reliableStatus.ToString());
The third RPC message.

mail.Sendmail("mail receiver", "subject 3", "Text 3");

Check the status: get the new message ID and use it to retrieve the status.

mail.service.GetReliablelID(ref reliablelD);
mail.service.GetReliableStatus(reliablelID, ref reliableStatus);
Console.Out.WritelLine("Reliable ID = " + reliablelID.ToString());
Console.Qut.WritelLine("Reliable Status = " + reliableStatus.ToString());

Roll back the third message and check status.

mail.service.ReliableRollback();
mail.service.GetReliableStatus(reliablelID, ref reliableStatus);

Console.Out.WriteLine("Reliable ID = " + reliablelID.ToString());
Console.Out.WritelLine("Reliable Status = " + reliableStatus.ToString());

mail.service.broker.logoff();
Limitations

1. All program calls that are called in the same transaction (CLIENT_COMMIT) must be in the same
IDL library.

2. Itis not allowed to switch from CLIENT COMMIT to AUTO_COMMIT in a transaction.

3. Messages (IDL programs) must have IN parameters only.
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Writing a Server

There are no server-side methods for reliable RPC. The server does not send back a message to
the client. The server can run deferred, thus client and server do not necessarily run at the same
time. If the server fails, it throws an exception. This causes the transaction (unit of work inside the
broker) to be cancelled, and the error code is written to the user status field of the unit of work.

Broker Configuration

A Broker configuration with PSTORE is recommended. This enables the Broker to store the messages
for more than one Broker session. These messages are still available after Broker restart. The attrib-
utes STORE, PSTORE, and PSTORE-TYPE in the Broker attribute file can be used to configure this
feature. The lifetime of the messages and the status information can be configured with the attributes
UOW-DATA-LIFETIME and UOW-STATUS-LIFETIME. Other attributes such as MAX-MESSAGES-IN-UQW,
MAX-UOWS and MAX-UOW-MESSAGE-LENGTH may be used in addition to configure the units of work.
See Broker Attributes.

The result of the function Service.GetReliableStatus depends on the configuration of the unit
of work status lifetime in the EntireX Broker configuration. If the status is not stored longer than
the message, the function returns the error code 00780305 (no matching UOW found).
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B A DU S et e

= Classes
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Attributes

Attribute classes are defined and implemented in the .NET Wrapper runtime and used in the C#
client interface object code to hold information extracted from the IDL file.

EntireXVersionAttribute
This attribute contains version information.

Example

[EntireXVersion("10.7.0.0")]
public class Example

LibraryAttribute
This attribute contains the library name.

Example

[Library("EXAMPLE")]
public class Example

BrokerAttribute
This attribute contains the Broker ID.

Example (without SSL)

[Broker("localhost:1971")]
public class Example

Example (with SSL)

[Bde("ss]://laalist:2Z10 st store:\SoftwareG\ntire/etie/BeGiart. jlley store:\SoftwareQintireX/ei/Bedaetiart. jolley prsabedaetat™)]
public class Example
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ServiceAttribute
This attribute contains the service name.

Example

[Service("RPC/SRV1/CALLNAT")]
public class Example

ProgramAttribute
This attribute contains the program name.

Example

[Program("CALC")]

public int Calculator(
[SendAs(Id1Type.A, Length=1f)][In] string operation,
[SendAs(Id1Type.I4)1[In] int operandl,
[SendAs(Id1Type.I4)][In] int operand2

)

SendAsAttribute

This attribute contains type, length (fixed or dynamic) and dimension (fixed or dynamic) inform-
ation.

Direction Attributes (In, Out)
These attributes contain direction information. They are supported natively by C#.

Example

[Program("HELLO")]
public void Hello(
[SendAs(Id1Type.A, Length=80f)I[In] string client,
[SendAs(Id1Type.A, Length=80f)][In, OQut] ref StringBuilder mail
)
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Classes

The NET Wrapper runtime defines and implements several generic service classes that are used
in the generated C# client interface object and by .NET client applications.

BigNumeric

Implementation of decimal values without upper and lower limit and a default number of 99 digits
after the decimal sign.

Constructors

public BigNumeric ( BigNumeric number )

Copy Constructor.

public BigNumeric ( decimal number )

Constructor translating a decimal number into a BigNumeric value.

public BigNumeric ( Int32 number )

Constructor translating an Int32 number into a BigNumeric value.

public BigNumeric ( Inté64 number )

Constructor translating an Int64 number into a BigNumeric value.

public BigNumeric ( double number )

Constructor translating a double to its exact BigNumeric representation.

public BigNumeric ( string number )

Constructor converting the string representation of a number into a BigNumeric object. The string
representation consists of an optional sign, '+' or -, followed by a sequence of zero or more
decimal digits, optionally followed by a fraction which consists of a decimal point followed by
zero or more decimal digits and optionally followed by an exponent which consists of the character
‘e’ or 'E' followed by one or more decimal digits. The value must not exceed the size of the N(U)/P(U)
data type.
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public BigNumeric ( string number , CulturInfo info )

Constructor converting the string representation of a number into a BigNumeric object. The desired
culture info is used to interpret the numeric string.

Methods

public int GetHashCode()

Returns the hash code of the instance.

public string ToString()

Converts the value of the instance to its string representation.

public string ToString( NumberFormatInfo info )

Converts the value of the instance to its string representation using the desired number format.

public BigInteger Truncate()

Returns the integral part of the number.

public BigNumeric Truncate ( int scale )

Returns a new BigNumeric with a maximum number of digits after the decimal sign. The number
is truncated to the desired precision if necessary.

public BigNumeric Round ( int scale )

Returns a new BigNumeric with a maximum number of digits after the decimal sign. The number
is rounded to the desired precision if necessary. Rounding is performed according to the rounding
mode "HALF_UP" of Java class BigDecimal.

public bool isNegative()

Returns true for negative numbers.

public static BigNumeric Random ( int preDecimal , int postDecimal )

Create a random BigNumeric number with the desired number of predecimal and a maximum of
99 postdecimal digits.
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Operators

public static BigNumeric operator + ( BigNumeric operandl , BigNumeric operand? )

Adds two BigNumerics. The result inherits the scale of operand1.

public static BigNumeric operator - ( BigNumeric operandl , BigNumeric operand?2 )

Subtracts two BigNumerics. The result inherits the scale of operandl.

public static BigNumeric operator * ( BigNumeric operandl , BigNumeric operand? )

Multiplies two BigNumerics. The result inherits the scale of operand1.

public static BigNumeric operator / ( BigNumeric operandl , BigNumeric operand? )

Divides two BigNumerics. The result inherits the scale of operand]l.

public static implicit operator BigNumeric ( decimal value )

Converts a decimal value to a BigNumeric.

public static implicit operator BigNumeric ( Int32 value )

Converts an int value to a BigNumeric.

public static implicit operator BigNumeric ( Int64 value )

Converts a long value to a BigNumeric.

public static explicit operator Decimal ( BigNumeric value )

Converts the BigNumeric to a decimal, throws an exception if the value doesn't match the decimal's
numeric range.

public static bool operator < ( BigNumeric left , BigNumeric right )

Compares the value of two BigNumerics.

public static bool operator <= ( BigNumeric left , BigNumeric right )

Compares the value of two BigNumerics.
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public static bool operator > ( BigNumeric left , BigNumeric right )

Compares the value of two BigNumerics.

public static bool operator >= ( BigNumeric left , BigNumeric right )

Compares the value of two BigNumerics.

public static bool operator == ( BigNumeric left , BigNumeric right )

Compares the value of two BigNumerics.

public static bool operator != ( BigNumeric left , BigNumeric right )

Compares the value of two BigNumerics.

bool Equals ( object o )

Compares the desired object with the value of this.

public static bool operator < ( BigNumeric Teft , Decimal right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator <= ( BigNumeric left , Decimal right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator > ( BigNumeric Teft , Decimal right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator >= ( BigNumeric left , Decimal right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator == ( BigNumeric left , Decimal right )

Compares the value of a BigNumeric with the value of a decimal.
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public static bool operator != ( BigNumeric left , Decimal right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator < ( Decimal Teft , BigNumeric right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator <= ( Decimal Tleft , BigNumeric right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator > ( Decimal left , BigNumeric right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator >= ( Decimal Teft , BigNumeric right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator == ( Decimal Tleft , BigNumeric right )

Compares the value of a BigNumeric with the value of a decimal.

public static bool operator != ( Decimal left , BigNumeric right )

Compares the value of a BigNumeric with the value of a decimal.

Properties

public static BigNumeric Zero

Returns a BigNumeric representing the value 0

public static BigNumeric One

Returns a BigNumeric representing the value 1

public static BigNumeric MinusOne

Returns a BigNumeric representing the value -1
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public int Scale
Set/Get maximum number of digits after decimal sign
Broker

This class represents an EntireX Broker session and handles the connections to the Broker.

Constructors

public Broker()
Default Broker for default user.
The values for the default Broker and user are taken in the following order

® from the application's configuration file or
® from the [Broker] attribute of the client interface object (Broker values only) or

" from hard-coded constants Tocalhost:1971 and ERX-USER.

public Broker(string hostName)

Broker on hostName for default user (ERX-USER). See Examples.

public Broker(string hostName, string userName)

Broker on hostName for userName.

public Broker(string hostName, string userName, string token)

Broker on hostName for userName with token.

Methods

public void Logon()

Performs a logon to the Broker with the default user ID and password (that were set, for example,

with the UserID and Password property).
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public void Logon(string password)

Performs a logon to the Broker with the given password.

public void Logon(string password, string newPassword)

Performs a logon to the Broker with the given password and changes the password tonewPassword

public void Logon(string userID, string token, string password)

Performs a logon to the Broker with the given user ID, token and password

public void Logoff()

Performs a logoff from the Broker.

Properties

public bool Forcelogon

Specifies whether force logon is performed. The default is false.

public char BrokerSecurity

Sets or retrieves the level and type of Broker security to be used.

'N': no security
"Y' : default EntireX Security
'C' : user-specific security

public int Compressionlevel

Specifies what compression level should be used. Possible values are in the range 0 to 9.
The following values have a dedicated purpose.

0: do not compress

1: use compression method with best speed
6: use default compression

8: deflated

9: use best compression

The default value is 0 (no compression)
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public string BrokerID

Retrieves the Broker ID of the given Broker class instance. This property is read-only.

public string Password

Sets the password of a given Broker class instance for subsequent authentication. This property
is write-only.

public bytel[] SecurityToken

Sets or retrieves the security token of a given Broker class instance. The default value is null.

public string Token

Sets or retrieves the token of the given Broker class instance. The default value is null.

public string UserlID

Sets or retrieves the user ID of the given Broker class instance for subsequent authentication.

public string ApplicationName

The application name used for the client calls. Max. 64 characters. Set this property before calling
one of the Logon methods if you want to replace the default application name.

public Compress Compression

Deprecated. Use property CompressionLevel instead.

Example

Broker broker = new Broker("ibm2:3762", "ERX-USER");
broker.Logon("ERX-PASS");
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Service
Constructors

public Service()

Default service with default Broker.

public Service(string TibraryName)

Service for given library with default Broker.

public Service(Broker broker)

Service for given Broker.

public Service(Broker broker, string trinity)

Service for given Broker and service name: class/server/service (for example RPC/SRV1/CALLNAT).

public Service(string Broker broker, string trinity, TibraryName)

Service for given Broker, service name: class/server/service and library.

Methods

public int SetReliableState(int uReliableState)
Set the Reliable State. Possible values:

RELIABLE_OFF (0) - default value
RELIABLE_AUTO_COMMIT (1)
RELIABLE_CLIENT_COMMIT (2)

See Reliable RPC for NET Wrapper.

public int ReliableCommit()

Do a commit in Reliable State RELIABLE_CLIENT_COMMIT.
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public int ReliableRolTback()

Do a rollback in Reliable State RELIABLE_CLIENT_COMMIT.

public int GetReliableID(ref StringBuilder ReliablelD)

Get the ReliablelD.

public int GetReliableStatus(StringBuilder ReliablelID, ref StringBuilder <
ReliableStatus)

Get the Reliable Status. Possible values:

RECEIVED
ACCEPTED
DELIVERED
BACKEDOUT
PROCESSED
CANCELLED
TIMEOUT
DISCARDED

See Broker ACI Fields for more information.

public void CloseConversation()

Close an RPC conversation.

public void CloseConversationCommit()

Close an RPC conversation and commit.

public void UserIDAndPassword(string user, string password)

Specify user ID and password for a service.

public void OpenConversation()

Open an RPC conversation.
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public unsafe object Invoke ( string library , string method , params object[] <«
objArray )

where library  is the name of the class in the generated client interface object
method the name of the method to be invoked

objArray the methods parameters as an array of objects - the array size must fit the para-
meter count of the method .

Invoke returns the result (if any) of the invoked method.
The initialisation of the parameter array follows the rules:

1. Parameters of type groups, structs and arrays have to be assigned as follows

int[] numbers = new int[10] ;

objArrayl[i] = numbers ;

2. [in,out] and [out] parameters of the simple data types bool, char, byte, sbyte, decimal, float,
double, short, int and DateTime have to be assigned as follows:

int number = 4711 ;
objArray[i]l = new Ref ( ref number ) ;
where Ref is the class SoftwareAG.EntireX.NETWrapper.Runtime.Ref.

Note: The name of the class and the assembly name (file name) have to be identical. For

each class, a separate assembly is required. All these assemblies have to be placed in the
folder of the client executable or have to be configured according to the rules described
under .NET Framework Configuration in the RPC Server for .NET documentation.

Properties

public Encoding CharacterEncoding

Define an encoding for character translation. Defaultis System.Text.Encoding.GetEncoding(0)
(current locale). See also the NET Framework class library documentation for
System.Text.Encoding.
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public bool Naturallogon

Specify whether Natural logon should be performed. The default is false. If NaturalLogon is set
to true but no RPCUserID and RPCPassword have been defined, the runtime uses the Broker user
ID and password (provided the Broker password has been set with the Password property).

public Broker Broker

Sets or retrieves the Broker instance associated with the given Service instance.

public string RPCUserID

Sets or retrieves the RPC user ID of a given Service instance.

public string RPCPassword

Sets the RPC user password of a given Service instance.

public string ServerAddress

Retrieves the server address (class/server/service triplet) of a given Service instance.

public string Library

Sets or retrieves the library name of a given Service instance.

public Uint Timeout

Sets or retrieves the timeout value for a given Service instance. timeout = 0 is invalid. If 0 is set,
a default of 50 seconds will be used.

public string MessageIDOfRequest

Unique message ID of the request part of the last RPC call. Available for EntireX Broker version
10.1 and higher. See Unique Message ID under Broker ACI Functions for detailed explanation of
message IDs.

public string CorrelationIDOfReply

Unique message (correlation) ID of reply part of the last RPC call. Available for EntireX Broker
version 10.1 and higher. See Unique Message 1D under Broker ACI Functions for detailed explanation
of message IDs.
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Example

Service service = new Service( broker, "RPC/SRVI/CALLNAT", "EXAMPLE");
service.UserIDAndPassword("RPC-USER", "RPC-Password");

XException
Properties

public int errorCode

If an XException is thrown, errorCode contains the specific error code.

public string Message

If an XException is thrown, Message contains the specific error message. See Message Class 2002 -
.NET Wrapper.

Example

try {

} catch (EntireX.XException e) {
Console.WritelLine( e.Message ) ;
'

Qutput: "02150148: EntireX Broker not active.
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